
Properties

Manages the server properties of the selected computer. Use this command to display a summary of connections and resource 

use; to view a list of connected users, shared resources, and open resources; and to manage the computer description, directory 

replication, the logon script path, and the list of administrative alert recipients.

See Also

Managing Server Properties



Shared Directories

Manages shared directories on the selected computer. A shared directory can be accessed by network users. Use this command 

to share, stop sharing, modify properties, and manage permissions for shared directories.

See Also

Viewing Shared Directories

Sharing a Directory

Managing Properties for a Shared Directory

Setting Permissions for a Shared Directory

Stopping Directory Sharing



Services

Manages services. Use this command to stop, start, pause, continue, pass startup parameters to, and configure startup for 

services.

See Also

Starting and Stopping Services

Configuring Service Startup



Send Message

Sends your message to all users connected to the selected computer.

For a message to be sent and received, the Messenger service must be running on the computer sending the message and on 

the computers receiving the message.

See Also

Sending a Message to Connected Users



Promote To Primary Domain Controller

Promotes the selected server to primary domain controller. If it is available, the previous primary domain controller is 

automatically demoted to backup domain-controller status.

This command is available only when Server Manager displays a domain and a backup domain controller is selected. 

See Also

Promoting a Backup Domain Controller to Primary Domain Controller

Demoting a Primary Domain Controller to Backup Domain Controller



Demote to Backup Domain Controller

Usually, when a server is promoted to primary domain controller, no special action needs to be taken to demote the former 

primary-domain controller to backup domain-controller status; the system does this automatically.

However, if a server is promoted to primary domain controller while the existing primary domain controller is unavailable, and if 

the former primary domain controller later returns to service, you must demote it.

When a former primary domain controller returns to service under this circumstance and is selected in the Server Manager 

window, Promote To Primary Domain Controller becomes Demote To Backup Domain Controller. Until it is demoted, the 

former primary-domain controller does not run the Net Logon service or participate in authenticating user logons; in the Server 

Manager window, the icon for the controller appears dimmed.

See Also

Promoting a Backup Domain Controller to Primary Domain Controller

Demoting a Primary Domain Controller to Backup Domain Controller



Synchronize with Primary Domain Controller

This command is available only when a backup domain controller is selected.

This command performs a full synchronization of the domain-directory database of the primary domain controller with the 

selected backup domain controller. During full synchronization, the entire directory database is replicated to the selected server. 

This command also reestablishes the server-computer account password between the selected server and the primary domain 

controller. 

Full synchronization is automatically performed by the system when a backup domain controller cannot be fully updated by a 

partial synchronization. If a backup domain controller is unsynchronized or is unable to establish network connections because of 

password failure, an administrator can use this command to manually initiate a full synchronization. Over a wide area network 

(WAN) connection, full synchronization can take a substantial amount of time to complete and is not recommended.

See Also

Synchronizing a Backup Domain Controller with the Primary Domain Controller

Synchronizing All Backup Domain Controllers of the Domain



Synchronize Entire Domain

This command is available only when the primary domain controller is selected.

This command performs a partial synchronization of the domain directory database from the primary domain controller to all 

backup domain controllers. During partial synchronization, only the latest changes to the domain directory database are 

replicated.

Partial synchronization is automatically performed by the system at timed intervals, but if servers become unsynchronized, or if a 

particular update is needed as soon as possible, this is a manual way to force partial synchronization. It is rarely necessary. 

See Also

Synchronizing All Backup Domain Controllers of the Domain

Synchronizing a Backup Domain Controller with the Primary Domain Controller



Add to Domain

Before a computer running Windows NT can be a domain member and participate in domain security, it must be added to the 

domain. Computers that are added to a domain are given accounts in the domain directory database. There are three ways to 

add computers to a domain, but only one of them requires Server Manager. That method uses Add To Domain on the Server 

Manager Computer menu.
A computer can be added to a domain during installation of Windows NT Workstation or Windows NT Server, but only 

when the installation is performed by a domain Administrator.
An Administrator can add an existing computer running Windows NT to a domain by using the Network tool in Control 

Panel on that computer.
An Administrator or an Account Operator can use Add To Domain to add a computer account to the domain-directory 

database. The user must have the computer join the domain under that computer account. This can be accomplished by a user as 
part of Windows NT Workstation or Windows NT Server installation or, for any computer other than primary or backup domain 
controllers, by using the Network tool in Control Panel after installation.

Note
Treat the added computer name as a security element. Until the intended computer joins the domain, it is possible for a 

user to give a different computer that computer name, and then have it join the domain using the computer account you have just 
created. If the added computer is a server, when it joins it receives a copy of the domain directory database.

See Also

Adding a Computer to the Domain



Remove from Domain

Removes the selected computer from the domain. The computer account is deleted from the domain directory database, and it 

can no longer participate in domain security. 

The primary domain controller cannot be removed.

See Also

Removing a Computer from the Domain



Select Domain

Displays a different domain, a workgroup running Windows NT, or an individual computer. When Server Manager starts, it 

displays your logon domain. 

See Also

Selecting a Domain

Using Low Speed Connection

Who Can Use Server Manager?



Exit

Quits Server Manager.



Servers

Displays only servers in the Server Manager window. Workstations are filtered from the display and are not shown. 

When Servers is enabled, a check mark appears next to it on the View menu, and (Servers) appears on the Server Manager 

title bar.

See Also

Displaying Servers, Workstations, or Both



Workstations

Displays only workstations in the Server Manager window. Servers are filtered from the display, and are not shown. 

When Workstations is enabled, a check mark appears next to it on the View menu, and (Workstations) appears on the Server 

Manager title bar.

See Also

Displaying Servers, Workstations, or Both



All

Displays both servers and workstations in the Server Manager window. When All is enabled, a check mark appears next to it on 

the View menu.

See Also

Displaying Servers, Workstations, or Both



Show Domain Members Only

Filters the display so that the list of computers displayed in the Server Manager window is composed of only those computers 

that are actual members of the domain: computers running Windows NT. When Show Domain Members Only is enabled, a 

check mark appears next to it on the View menu.

By default, Show Domain Members Only is not checked and the list contains both the computers that are members of the 

domain and the computers that the Computer Browser service reports as active on the domain. 

See Also

Displaying Domain Members Only



Refresh

When Server Manager starts (and every time Select Domain is used), Server Manager receives information necessary to create 

the computer list displayed in the Server Manager window. The information is refreshed (updated with current data) after some 

other Server Manager functions, such changing computer properties, managing services, or promoting a server to primary 

domain controller. (These refreshes do not occur when the Low Speed Connection option has been selected.)

A refresh can be initiated by a user, by clicking Refresh on the View menu.

See Also

Refreshing the View

Using Low Speed Connection



Low Speed Connection

Used when administering a domain, workgroup, or computer that communicates with your computer across a connection 

providing relatively low transmission rates. This prevents automatic refresh of the Server Manager screen, which may be time 

consuming when performed across low speed connections. (Refreshes occur automatically after some Server Manager 

functions, such changing computer properties, managing services, or promoting a server to primary domain controller.) When 

Low Speed Connection is enabled, a check mark appears next to it on the Options menu.

In Low Speed Connection mode, the Server Manager screen can still be manually refreshed by clicking Refresh on the View 

menu.

Low Speed Connection can also be selected (or cleared) in the Select Domain dialog box at the same time you select a 

domain, workgroup, or computer to be displayed by Server Manager.

See Also

Using Low Speed Connection

Selecting a Domain



Save Settings On Exit

When you quit Server Manager, if Save Settings on Exit is enabled (indicated by a check mark appears next to it on the 

Options menu) the main window size and position and the View menu settings are saved.



Font

Changes the font used for the list of computers in the Server Manager main window.



Contents

Lists Server Manager Help topics.



Search for Help On

Presents an index of keywords from Server Manager Help. Associated Help topics can be listed, selected, and opened.



How to Use Help

Provides introductory information about accessing and using the online Help system.



About Server Manager

Provides the version number, serial number, copyright, licensing, and other information about Microsoft Windows NT Server 

Manager.



What Is Server Manager?

Server Manager is a tool you can use to manage domains and computers. With Server Manager you can:
Select a domain, workgroup, or computer to be administered.
Manage a computer. For a selected computer you can view a list of connected users, view shared and open resources, 

manage directory replication, manage the list of administrative alert recipients, manage services and shared directories, and send 
messages to connected users. 

Manage a domain. When administering a domain you can promote a backup domain controller to become the primary 
domain controller, synchronize servers with the primary domain controller, and add computers to and remove computers from the 
domain.

Some of the capabilities offered by Server Manager are also offered by the Services and Server tools in Control Panel of every 

Windows NT computer. However, Server Manager can manage both local and remote computers, while these Control Panel 

tools affect only the local computer.



The Server Manager Window

In most cases, when Server Manager is first started it displays your logon domain. The Server Manager title bar shows the 

domain name, and the body of the Server Manager window lists the computers of that domain. You can select a computer from 

this list and then use commands on the Computer menu be to manage it.

Click the following buttons for more information about the Server Manager window.

 Title bar
 Menu bar
 List of computers
 Computer icons
 Computer column
 Type column
 Description column



Title bar

The title bar of the Server Manager window names the domain, workgroup, or computer that is displayed for administration. 

When you enable View menu filtering commands, a notation of (Servers) or (Workstations) appears on the title bar, to the right of 

the domain, workgroup, or computer name.



Menu bar

The menu bar contains four menus.
Computer. Use these commands to view and manage domains, workgroups, and computers.
View. Use these commands to filter the displayed list of computers, to remove filtering, and to update Server Manager 

with current information.
Options. Use these commands to select or clear Low Speed Connection and Save Settings on Exit. 

You can also customize the look of Server Manager by adjusting the Font settings.
Help. Use commands on this menu to see online Help.



List of computers

The body of the Server Manager window lists the computers of the domain selected for administration (that is, the domain whose 

name is displayed in Server Manager's title bar). This list contains both computers that are members of the domain and 

computers that the Computer Browser service reports as active in the domain. 

The list can contain these kinds of computers: servers running Windows NT Server, computers that are running both 

Windows NT Workstation and the Server service, and Microsoft LAN Manager servers. Computers running Microsoft Windows 

95 or Windows for Workgroups might also appear in the list, but they cannot be administered with Server Manager because they 

do not support remote administration.

When you select a Windows NT workgroup for administration, the computers of that workgroup appear on the list. When you 

select an individual computer for administration, only that computer appears on the list. You can use commands on the View 

menu to filter the list of computers.



Computer icons

An icon graphically indicates the type of each listed computer.

Primary Domain Controller. Maintains the domain directory 

database and authenticates network logons.

Backup Domain Controller or Server. Backup domain 

controllers receive a copy of the domain directory 

database and authenticate network logons. Servers in the 

domain can use the domain user accounts through pass-

through authentication.

Workstation. Any other listed computer.

If a computer running Windows NT is unavailable to the network (for example, if it is turned off), its icon appears dimmed.



Computer column

Provides the computer name for each listed computer.



Type column

States the operating system, the version number of the operating system for each listed computer, and whether each of the 

computers is a primary domain controller, backup domain controller, server, or workstation. 

For example, a computer might be shown as a Windows NT 3.50 Primary.

If a computer running Windows NT is unavailable to the network (for example, if it is turned off), its description is blank.



Description column

Contains descriptive text, if any exists, for each listed computer.

The description is an optional entry. You can use Properties on the Computer menu to edit an entry. Typically, you might include 

information such as the location of the computer, the name of the computer user, the user's telephone extension, the brand or 

model of the computer, or a description of the computer's function. 

If a computer running Windows NT is unavailable to the network (for example, if it is turned off), its description is blank. 



Who Can Use Server Manager?

To administer a domain and its servers using Server Manager, you must be logged on to a user account that is a member of the 

Administrators, Domain Admins, or Server Operators group for that domain. Members of the Account Operators group can also 

use Server Manager, but only for the purpose of adding computers to the domain.

To use Server Manager to administer a workstation computer or server running Windows NT that is not a domain controller, you 

must be logged on to a user account that is a member of the Administrators or Power Users group for that computer. 

A few Server Manager functions are allowed for only Administrators or Domain Admins. When Server Operators, Account 

Operators, or Power Users attempt to perform these functions, a message appears indicating that access is denied.



Selecting a Domain

To change the domain displayed by Server Manager

1 On the Computer menu, click Select Domain.

2  In Domain, enter the name of a domain, Windows NT workgroup, or individual computer.

Precede computer names with two backslashes.

3 If the domain, workgroup, or computer you have specified communicates with your computer over a low speed connection, 

click Low Speed Connection.

The system saves the Low Speed Connection setting for each of the last 20 domains, workgroups, or computers you have 

administered. After you specify a name, the previous setting (if any) appears. If no previous setting is known, the option is 

initially cleared. You can accept or change the setting.

Notes
In most cases, Server Manager displays your logon domain when it starts. Use Select Domain on the Computer menu to 

display a different domain, a workgroup running Windows NT, or an individual computer.
A domain is a collection of computers that are grouped for viewing purposes and that share a common directory database. 

A workgroup is a collection of computers that are grouped only for viewing purposes.

See Also

Who Can Use Server Manager?

Using Low Speed Connection



Displaying Servers, Workstations, or Both

To display only servers

On the View menu, click Servers. 

A notation of (Servers) appears on the title bar, and a check mark appears next to Servers on the View menu.

To display only workstations

On the View menu, click Workstations. 

A notation of (Workstations) appears on the title bar, and a check mark appears next to Workstations on the View menu.

To display both servers and workstations

On the View menu, click All.

Note
By default, the list of computers in the Server Manager window includes both servers and workstations.



Displaying Domain Members Only

To display only those computers that are members of the domain

On the View menu, click Show Domain Members Only. 

A check mark appears next to the command. 

To remove filtering and display all computers

On the View menu, click Show Domain Members Only.

The check mark by the command is removed.

Note
By default the list of computers displayed in the Server Manager window contains those computers that are members of 

the domain, plus those computers that are listed by the Computer Browser service as active in the domain. Optionally, you can filter 
the list to display only those computers that are members of the domain. This will be Windows NT computers and LAN Manager 2.x 
servers.



Refreshing the View

When Server Manager starts, and every time you click Select Domain, Server Manager receives the information necessary to 

create the computer list displayed in the Server Manager window. The information is refreshed (updated with current data) after 

some Server Manager functions, such as changing computer properties, managing services, or promoting a server to primary 

domain controller. However, these refreshes do not occur when Low Speed Connection is selected.

A refresh can also be initiated by a user.

To refresh the view with current information

On the View menu, click Refresh.

See Also

Using Low Speed Connection



Using Low Speed Connection

To select or clear Low Speed Connection when the domain, Windows NT workgroup, or computer are not yet displayed 

by Server Manager

1 Select a domain, Windows NT workgroup, or computer to be displayed by Server Manager. 

2 Click Select Domain on the Computer menu.

3 In the Select Domain dialog box, click to set or clear the Low Speed Connection check box.

To select or clear Low Speed Connection when the domain, Windows NT workgroup, or computer are already displayed 

by Server manager

On the Options menu, click Low Speed Connection. 

Notes
Low Speed Connection prevents automatic refresh of the Server Manager screen, which may be time consuming when 

performed across low speed connections. (Refreshes occur automatically after some Server Manager functions, such changing 
computer properties, managing services, or promoting a server to primary domain controller.)

The system saves the Low Speed Connection setting for each of the last 20 domains, workgroups, or computers you 
have administered. After you specify a name in the Select Domain dialog box, the previous state of this option (if any) is initially set. 
You can accept or change this setting.

If you have not previously administered the specified domain, workgroup, or computer, and if you do not select Low 
Speed Connection in the Select Domain dialog box, the system automatically determines the appropriate connection mode and 
selects or clears Low Speed Connection after you click OK. After connecting, you still have the option of changing the setting by 
clicking Low Speed Connection on the Options menu.

Also, when starting Server Manager from the command prompt, you can optionally append the low speed connection 
parameter [/l] or the normal (high speed) connection parameter [/h]. 

For example, to start Server Manager and administer the domain Shipping using Low Speed Connection, you would type 

srvmgr shipping /l.

See Also

Selecting a Domain

Refreshing the View



Managing Server Properties

To manage properties

1 In the Server Manager window, double-click a computer name.

The Properties dialog box appears, displaying usage statistics for Sessions, Open Files, File     Locks  , and Open Named Pipes. 

2 To change the computer description, type new text in Description.

3 To administer a property associated with a button at the bottom of the Properties dialog box, click the button and complete the 

dialog box for that property.

There are five buttons: Users, Shares, In Use, Replication, and Alerts.

4 When you finish managing properties, click OK in the Properties dialog box.

See Also

Viewing User Sessions

Viewing Shared Resources

Viewing Resources In Use

Managing Export Replication

Managing Import Replication

Setting the Logon Script Path

Managing Administrative Alerts



Viewing User Sessions

To view a list of users connected to the computer

1 In the Server Manager window, double-click a computer name.

2 In the Properties dialog box, click Users.

3 To view the resources opened by one user, select a user name in Connected Users, which opens the display below of the 

shared Resource that user connects to, Opens, and Time. 

4 To exit click Close, and then click OK in the Properties dialog box.

Tips
To disconnect one user, select the user name from Connected Users and then click Disconnect. 

Or, to disconnect all users, click Disconnect All. Warn connected users before disconnecting them
In the Users Sessions dialog box, status information appears for Connected Users, Computer, Opens, Time, Idle, and 

Guest. The Connected Users summary shows the number of users remotely connected to the computer. 
While you are remotely administering another computer, your user account will be listed as a user connected to the IPC$ 

resource. It cannot be disconnected.

See Also

Viewing Shared Resources

Viewing Resources In Use

Special Shares



Viewing Shared Resources

To view a list of the computer's shared resources

1 In the Server Manager window, double-click a computer name.

2 In the Properties dialog box, click Shares.

The Shared Resources dialog box appears. The Sharename box lists the shared resources available on the computer, the 

Uses, and the Path.

3 To view the users connected to a shared resource, select a share name in Share Name. 

The Connected Users box lists Connected Users, Time, and In Use. Below Connected Users, the Connected Users 

summary shows the number of users connected to the selected resource.

Tips
To disconnect one user from all shared resources, select the user name in Connected Users and then click Disconnect. 

Or, to disconnect all users from all shared resources, click Disconnect All. 
Warn connected users before disconnecting them. Each disconnected user is disconnected from all shared resources on 

the computer (not just the resource selected in the Sharename box).
To share printers or manage shared printers, click Shared Directories on the Server Manager Computers menu, or use 

Windows NT Explorer. 
While you remotely administer another computer, your user account will be listed as a connected user for the IPC$ share. 

It cannot be disconnected.

See Also

Viewing User Sessions

Viewing Resources In Use

Sharing a Directory

Managing Properties for a Shared Directory

Special Shares



Viewing Resources In Use

To view a list of the computer's open shared resources

1 In the Server Manager window, double-click a computer name.

2 In the Properties dialog box, click In Use.

The Open Resources dialog box appears. Opened By lists the computer's open resources.

3 If needed, click Refresh to update the displayed information.

4 To exit, click Close, and then click OK in the Properties dialog box.

Tips
To close an open resource, select that resource in In Use, and then click Close Resource. 

Or, to close all open resources, click Close All Resources.
Always warn connected users before closing resources.
While you are remotely administering another computer, your connection will be displayed here as an open named pipe. It 

cannot be closed.

See Also

Viewing User Sessions

Viewing Shared Resources

Sharing a Directory

Managing Properties for a Shared Directory

Special Shares



Managing Export Replication

To set up an export server

1 Use Windows NT Explorer to create the subdirectories that will be exported and, optionally, add to these the files that will be 

exported. These must be subdirectories of the replication From Path.

2 In the Server Manager window, double-click the computer name of the replication export server.

3 In the Properties dialog box, click Replication. 

4 In the Directory Replication dialog box, select Export Directories.

If necessary, you can change the path from which subdirectories will be exported by typing a local path in the From Path box.

5 Change any of the following, as needed.
To export subdirectories to a domain or computer, click Add in Export Directories, and then complete the Select 

Domain dialog box that appears. The domain name or computer name is added to the To List.
To stop exporting subdirectories to a domain or computer, select the domain or computer from the To List under Export 

Directories, and then click Remove.
To manage locks, stabilization, and subtree replication for the subdirectories exported from this computer, click Manage 

under Export Directories, and then complete the dialog box that appears.

6 When you finish making changes, click OK in the Directory Replication dialog box.

If it does not already exist, the system creates the special REPL$ share, required for export replication. If it is not already 

running, the system starts the Directory Replicator service.

Important
Make sure an appropriate logon account has been assigned to the Directory Replicator service before performing this 

procedure.

Tips
It is not necessary to add files when you create the subdirectories (in step 1, above). Once you set up replication, any files 

later added to these subdirectories will automatically be exported. You can also add additional subdirectories to the replication From 
Path.

By default, the To List contains a blank entry and this computer automatically exports to the local domain. If any entries 
are added to the To List, exports are no longer made to the local domain. If necessary, the domain name must be explicitly added to 
the To List. Only servers running Windows NT Server (not Windows NT Workstation) can be set up as replication export. 

See Also

Assigning a Logon Account to the Directory Replicator Service

Managing Import Replication

Setting the Logon Script Path

Special Shares

Managing Locks, Stabilization, and Subtree Replication for Export Directories

Viewing a List of, or Managing Locks for, Imported Subdirectories



Directory Replication

Directory replication is the duplication of a master set of directories from a server (called an export server) to specified servers or 

workstations (called import computers) in the same or other domains. A server running Windows NT Server can be an export 

server, an import computer, or both. A workstation can be only an import computer.

Replication simplifies the task of maintaining identical sets of directories and files on multiple computers, because only a single 

master copy of the data must be maintained. Once replication is set up, replication occurs each time a change is made to one of 

the files in a directory set for export.



Directory Replicator service

Before replication can occur, an appropriate logon account must be assigned to the Directory Replicator service of each 

computer that will participate in replication.

Use the User Manager for Domains to create a domain user account that the Directory Replicator service will use to log on. This 

account must have Password Never Expires selected, all logon hours allowed, and membership in the domain Backup 

Operators group.

For each computer that will participate in replication, use Server Manager to configure the Directory Replicator service to start up 

automatically, and to log on using the user account described above.



Managing Import Replication

To set up an import computer

1 In the Server Manager window, double-click the appropriate computer name.

2 In the Properties dialog box, click Replication. 

3 In the Directory Replication dialog box, select Import Directories.

4 Optionally, to change the path in which imported subdirectories will be stored, type a local path in the To Path box.

5 Change any of the following, as needed, and then click OK to exit the Directory Replication dialog box.
To import subdirectories from a domain or export server, click Add under Import Directories, and then complete the 

Select Domain dialog box that appears. The domain name or computer name is added to the From List.
To stop importing subdirectories from an export server or domain, select the domain name or computer name in the From 

List, and then click Remove.
To view a list of the subdirectories that have been imported to this computer, or to manage locks on those imported 

subdirectories, click Manage under Import Directories, and then complete the dialog box that appears.

Notes
Make sure an appropriate logon account has been assigned to the Directory Replicator service before performing the 

following procedure.
By default, the From List contains a blank entry, and this computer automatically imports from the local domain. If any 

entries are added to the From List, imports are no longer made from the local domain. If necessary, the domain name must be 
explicitly added to the From List.

Any computer running Windows NT can be set up as a replication import computer. 
You can configure the import computer to import from multiple domains and computers but not to a single subdirectory. If 

you attempt to do this, each subsequent update of that subdirectory by a different domain or computer will remove the current files 
from the import subdirectory.

See Also

Assigning a Logon Account to the Directory Replicator Service

Managing Export Replication

Setting the Logon Script Path



Managing Locks, Stabilization, and Subtree Replication for Export Directories

To manage locks, stabilization, and subtree replication for the subdirectories exported from this computer

1 In the Directory Replication dialog box, click Manage in Export Directories. 

2 To temporarily stop exporting a subdirectory, select the subdirectory from the list and then click Add Lock. 

Or, to resume exporting a locked subdirectory, select the subdirectory and then click Remove Lock.

3 To export a subdirectory and all the subdirectories in its tree, select the subdirectory and then select the Entire Subtree check 

box. 

Or, to export only the highest subdirectory in a tree, select the subdirectory and then click to clear the Entire Subtree check 

box.

4 To specify a two-minute or longer wait-period during which no changes can occur before files are exported, select a 

subdirectory and then select the Wait Until Stabilized check box. 

Or, to export files immediately after they are changed and saved, select a subdirectory and then click to clear the Wait Until 

Stabilized check box.

5 To return to the Directory Replication dialog box, click OK.

Note
Usually, you should remove only locks that you have applied. Exporting resumes only when the Locks column shows a 

value of 0 for the subdirectory.

See Also

Viewing a List of, or Managing Locks for, Imported Subdirectories



Viewing a List of, or Managing Locks for, Imported Subdirectories

To view a list of, or manage locks for, imported subdirectories

1 In the Directory Replication dialog box, click Manage in Import Directories.

2 To temporarily stop importing to a subdirectory, select the subdirectory from the list and then click Add Lock.

3 To resume importing to a locked subdirectory, select the subdirectory and then click Remove Lock.

Note
Usually, you should remove only locks that you have applied. Import resumes only when the Locks column shows a value 

of 0 for the subdirectory.

See Also

Managing Locks, Stabilization, and Subtree Replication for Export Directories



Setting the Logon Script Path

To configure the logon script path for a server

1 In the Server Manager window, double-click the computer name of the server.

2 In the Properties dialog box, click Replication.

3 In the Logon Script Path box, type a local path.

Usually, you will enter a path to a \SCRIPTS subdirectory of the replication To Path. For example, C:

\WINNT\SYSTEM32\REPL\IMPORT\SCRIPTS.

An entry is required. Do not enter a blank in the Logon Script Path box.

4 To exit click OK, and then in the Properties dialog box click OK again.

Notes
A logon script is an optional file that runs each time a user logs on. It can be a batch file (.BAT or .CMD filename 

extension) or an executable program (.EXE filename extension). A logon script path is a local path to the directory where logon 
scripts are stored. 

For computers running Windows NT Workstation, the logon script path cannot be changed from the default (usually, 
systemroot\SYSTEM32\REPL\IMPORT\SCRIPTS).

When a server authenticates a logon request and that user account has a logon script assigned, the system locates the 
logon script by combining a local logon script path specified in Server Manager with a filename (and optionally a relative path) 
specified in User Manager.

For a domain, master copies of every logon script should be stored under one replication export directory of one domain 
controller, either the primary domain controller or a backup. Copies of these master logon scripts should be replicated to the other 
servers of the domain. Then, for every other domain controller, the path to imported logon scripts must be entered in Logon Script 
Path of the Directory Replication dialog box.

See Also

Managing Export Replication

Managing Import Replication



Managing Administrative Alerts

To manage the recipients of administrative alerts

1 In the Server Manager window, double-click a computer name.

2 In the Properties dialog box, click Alerts.

3 To add a user or computer to the list of alert recipients, enter the user name or computer name in New Computer or 

Username, and then click Add.

4 To remove a user or computer from the list of alert recipients, select the user name or computer name in Send 

Administrative Alerts To, and then click Remove.

5 To exit, click OK in the Alerts dialog box and in the Properties dialog box.

6 Stop and restart the Server and Alerter services to put your changes into effect.

Note
You can determine which users and computers are notified when administrative alerts occur at a selected computer. 

Administrative alerts are generated by the system, and relate to server and resource use. They warn about security and access 
problems, user session problems, printer problems, and server shutdown because of power loss when the UPS service is available.



Viewing Shared Directories

To see the shared directories of a computer

1 In the Server Manager window, select a computer from the list.

2 On the Computer menu, click Shared Directories.

The Shared Directory dialog box lists the shared directories of the computer, and shows the path of each shared directory.

3 To exit, click Close.

See Also

Sharing a Directory

Managing Properties for a Shared Directory

Stopping Directory Sharing

Special Shares

Viewing Shared Resources

Viewing Resources In Use



Sharing a Directory

To share a directory

1 In the Server Manager window, select a computer from the list, and then click Shared Directories on the Computer menu.

2 In the Shared Directories dialog box, click New Share.

3 Type a Share Name, Path, and Comment.

4 To define the maximum number of users who can connect to the shared directory at one time, click either Maximum Allowed 

or Allow.

 If you select Allow, enter a maximum number in Users.

5 To manage the permission level granted to groups and user accounts, click Permissions and select settings in the Access 

Through Share Permissions dialog box that appears, and then click OK. 

Unless you change the default setting, a new shared directory provides Full Control to Everyone.

See Also

Stopping Directory Sharing

Setting Permissions for a Shared Directory

Viewing Shared Resources

Viewing Resources In Use



Managing Properties for a Shared Directory

To manage properties for a shared directory

1 Select a computer from the list in the Server Manager window, and then click Shared Directories on the Computer menu.

2 In the Shared Directories dialog box, select a share name from the list.

3 Click Properties. 

4 To change the Path or Comment, type new text in those boxes.

5 To change the maximum number of users who can connect to the shared directory at one time, select either Maximum 

Allowed or Allow. 

If you select Allow, specify a maximum number in Users.

6 To change the permission level granted to groups and user accounts, click Permissions and complete the Access Through 

Share Permissions dialog box that appears; then click OK.

See Also

Setting Permissions for a Shared Directory
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Setting Permissions for a Shared Directory

To set permissions for a shared directory

1 Select a computer from the list in the Server Manager window, and then click Shared Directories on the Computer menu. 

2 In the Shared Directories dialog box, click New Share.

Or, select a share name on the list and click Properties. 

3 Click Permissions.

4 Make any of the following changes.
To change a permission, select a group or user account in Name, and then select a permission in Type of Access.
To add a group or user account to the list of those granted permissions for this shared directory, click Add, and then 

complete the Add Users and Groups dialog box that appears
To remove a group or user account on the list of those granted permissions for this shared directory, select a group or 

user account in Name, and then click Remove.

5 When you finish making changes, click OK.

Tips
When assigning permissions it is usually better to assign permissions to groups rather than to individual user accounts 
Permissions set on a share that is on an NTFS volume operate in addition to NTFS permissions set on the directory itself. 

On NTFS volumes, share permissions specify the maximum access possible, while directory and file permissions specify the 
maximum access allowed. For NTFS volumes it is usually better to restrict access by managing the permissions set on directories 
and files, rather than the permissions set on shares.

See Also

Types of Access Permissions

Special Shares

Sharing a Directory

Managing Properties for a Shared Directory



To stop sharing a directory

1 Select a computer from the list in the Server Manager window, and then click Shared Directories on the Computer menu. 

2 In the Shared Directories dialog box, select a share name from the list.

3 Click Stop Sharing. 

The directory itself is not removed, but it is no longer shared and can no longer be accessed by network users.

Note
In most cases you should not select a share name for one of the special shares which, if it appears in the list, was created 

by the system (for example, A$, B$, C$, ADMIN$, IPC$, NETLOGON, PRINT$ or REPL$).

See Also

Sharing a Directory

Managing Properties for a Shared Directory
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Special Shares

A computer's shared resources include those resources (such as directories) that have been shared by a user or an 

administrator, plus any special shares that may have been created by the system.

Depending on the configuration of the computer being administered, some or all of the following special shares may appear 

when Windows NT presents a list of the computer's shared resources. These shares are created by the system. In most cases, 

these special shares should not be deleted or modified. 

For more information click the following buttons.
   driveletter  $  
 ADMIN$
 IPC$
 NETLOGON
 PRINT$
 REPL$

See Also

Viewing Shared Directories

Viewing Shared Resources



driveletter$

A share which allows administrative personnel to connect to the root directory of a storage device. Shown as A$, B$, C$, D$, and 

so on. 

For example, D$ is a share name by which drive D might be accessed by an administrator over the network.

For a workstation or server, only members of the Administrators and Backup Operators can connect to these shares. For a 

primary or backup domain controller, members of the Server Operators group can also connect to these shares.



ADMIN$

A resource used by the system during remote administration of a computer. The path of this resource is always the Windows NT 

system root (the directory in which Windows NT is installed: for example, C:\WINNT). 

For a workstation or server, only members of the Administrators and Backup Operators can connect to this share. For a primary 

or backup domain controller, members of the Server Operators group can also connect to this share.



IPC$

A resource sharing the named pipes that are essential for communication between programs. Used during remote administration 

of a computer, and when viewing a computer's shared resources.



NETLOGON

A resource used by the Net Logon service of a server running Windows NT Server while processing domain logon requests. 

Note
This resource is provided only for servers. It is not provided for computers running Windows NT Workstation.



PRINT$

A resource that supports shared printers.



REPL$

A resource created by the system when a server is configured as an replication export server. It is required for export replication.

Note
This resource is only provided for servers which are configured as replication export servers. It is not provided for 

computers running Windows NT Workstation.



Starting and Stopping Services

To start, stop, pause, or continue a service

1 Select a computer in the list in the Server Manager window, and then on the Computer menu click Services.

2 In the Services dialog box, select the service.

3 Click Start, Stop, Pause, or Continue.

4 Optionally, to pass startup parameters to a service, type the parameters in the Startup Parameters box before choosing 

Start. 

Backslashes are treated as an escape character. You must type two backslashes for each backslash in a parameter.

5 In the Services dialog box, click Close.

Notes
When you pause the Server service, users in the server’s Administrators and Server Operators groups can still make new 

connections to the computer, but all other users cannot.
Pause the Server Service and send a message to all connected users before you stop that service, because stopping the 

Server service disconnects all remote connected users. Also, once the Server service is stopped, that computer can no longer be 
remotely administered, and Server service can be restarted only locally.

See Also

Configuring Service Startup

The Default Services

Stopping the Server Service



Stopping the Server Service

To stop the Server service

1 On the Computer menu, click Services. 

2 Click Pause in the Services dialog to prevent new users from establishing a connection with the computer, and then click 

Close.

3 On the Computer menu, click Send Message and notify all connected users that they will be disconnected after a specified 

time period. 

4 When your warning period expires, click Services on the Computer menu, and then click Stop to stop the Server service on 

that computer. 

Notes
When you pause the Server service, users in the server’s Administrators and Server Operators groups can still make new 

connections to the computer, but all other users cannot.
Once the Server service on a computer is stopped, that computer can no longer be remotely administered. Its Server 

service can be restarted only locally.

See Also

Starting and Stopping Services



Configuring Service Startup

To configure startup for a service

1 Select a computer from the list in the Server Manager window, and then click Services on the Computer menu.

2 In the Services dialog box, select the service and click Startup.

3 In the Service Startup dialog box, click a startup type: Automatic, Manual, or Disabled.

4 To specify the user account the service will use to log on, click System Account or This Account.

5 If you select This Account, click the gray button to the right of the text box and select a user account in the Add User dialog 

box, and then click OK.

6 Type the password for the user account in both Password and Confirm Password, and then click OK.

Important
Most services must log on using the system account. 
To configure service startup, you must be logged on to a user account that has membership in the Administrators local 

group.

See Also

Assigning a Logon Account to the Directory Replicator Service

Assigning a Logon Account to the Schedule Service

The Default Services



Assigning a Logon Account to the Directory Replicator Service

To assign a logon account to the Directory Replicator service

1 Use User Manager for Domains to create a domain user account, configuring the account so that:
Password Never Expires is selected.
All logon hours are allowed.
The user account has membership in the domain Backup Operators group.

2 Use Server Manager to configure the Directory Replicator service (for each computer that will participate in replication) to start 

up automatically, and to log on using the user account you created in step 1.

Notes
Before a computer can participate in replication, you must create a special user account and then, for each computer in a 

domain that will participate in replication, configure its Directory Replicator service to log on using that special account.
Most aspects of directory replication are managed for a particular computer by using either the Server Manager Properties 

command or the Server tool in Control Panel.

See Also

Configuring Service Startup

The Default Services

Managing Export Replication

Managing Import Replication



Assigning a Logon Account to the Schedule Service

To assign a logon account to the Schedule service

1 Create a user account for the service using User Manager or User Manager for Domains, selecting the Password Never 

Expires check box.

2 Give the account membership in the appropriate groups. 

3 Assign the user account to the Schedule service using the Server Manager or the Services tool in Control Panel.

Notes
The Schedule service must be running if the AT command is to be used. The AT command can schedule commands and 

programs to run on a computer at a specified time and date. 
By default, the Schedule service is configured to log on under the system account; the same account that is used by most 

services. However, when the Schedule service logs on under the system account, the AT command can only be used to access 
those network resources that permit Guest access.

In many cases, you must create a special user account and then configure the Schedule service to log on using that user 
account if you want the AT command to access network resources.

The particular group memberships you assign will depend on the operations that must be accomplished remotely. 

For example, the user account created for the Schedule service must be a member of the domain's Backup Operators local 

group if the AT command is to be used to perform regularly scheduled backups of the hard disk of a remote server in a 

Windows NT Server domain.

See Also

Configuring Service Startup

The Default Services



The Default Services

The services listed below are provided with Windows NT Workstation and Windows NT Server. In addition to these default 

services, other services may be listed in the Services dialog box for a computer (for example, network transports or other 

services that have been installed on that computer).

For more information on the default services, click the following buttons.
 Alerter
 Clipbook Server
 Computer Browser
 Directory Replicator
 Event Log
 Messenger
 Net Logon
 Network DDE
 Network DDE DSDM
 NT LM Security Support Provider
 Remote Procedure Call (RPC) Locator
 Remote Procedure Call (RPC)
 Schedule
 Server
 Spooler
 UPS
 Workstation

See Also

Starting and Stopping Services

Configuring Service Startup



Alerter service

Notifies selected users and computers of administrative alerts that occur on the selected computer. Used by the Server and other 

services. Requires the Messenger service.



Clipbook Server service

Supports the Clipbook Viewer application, allowing pages to be seen by remote Clipbooks.



Computer Browser service

Maintains an up-to-date list of computers and provides the list to applications when requested. Provides the computer lists 

displayed in the Select Computer and Select Domain dialog boxes; and in the main Server Manager window.



Directory Replicator service

Replicates directories, and the files in those directories, between computers.



Event Log service

Records system, security, and application events in the event logs.



Messenger service

Sends and receives messages sent by administrators or by the Alerter service.



Net Logon service

Performs authentication of account logons for primary and backup domain controllers, and also keeps the domain directory 

database synchronized between the primary domain controller and the backup domain controllers of the domain.

For other computers running Windows NT, supports pass-through authentication of account logons. Used when the workstation 

participates in a domain.



Network DDE service

Provides a network transport as well as security for Dynamic Data Exchange (DDE) conversations.



Network DDE DSDM service

(Dynamic Data Exchange Share Database Manager) 

Manages the shared DDE conversations. It is used by the Network DDE service.



NT LM Security Support Provider service

Provides Windows NT security to Remote Procedure Call (RPC) applications that use transports other than named pipes.



Remote Procedure Call (RPC) Locator service

Allows distributed applications to use the Microsoft RPC name service. The RPC Locator service manages the RPC name 

service database.

The server side of a distributed application registers its availability with the RPC Locator service. The client side of a distributed 

application queries the RPC Locator service to find available compatible server applications.



Remote Procedure Call (RPC) service

The RPC subsystem for the Windows NT operating system. Includes the endpoint mapper and miscellaneous RPC services.



Schedule service

Must be running if the AT command is to be used. 

The AT command can be used to schedule commands and programs to run on a computer at a specified time and date. 



Server service

Provides remote procedure call (RPC) support, and file, print, and named pipe sharing.



Spooler service

Provides print spooler services.



UPS service

Manages an uninterruptible power supply connected to this computer.



Workstation service

Provides network connections and communications.



Sending a Message to Connected Users

To send a message to connected users

1 Select a computer from the list in the Server Manager Window.

2 On the Computer menu, click Send Message.

3 Type your message in Message, and then click OK.



Promoting a Backup Domain Controller to Primary Domain Controller

To promote a backup domain controller to primary domain controller

1 Select a backup domain controller from the list of computers in the Server Manager window. 

Choose a computer that is capable of reliably handling high network traffic loads.

2 On the Computer menu, click Promote To Primary Domain Controller.

If it is available, the former primary domain controller is demoted to backup domain controller status.



Demoting a Primary Domain Controller to Backup Domain Controller

To demote a primary domain controller to backup domain controller 

1 Select the former primary domain controller from the list of computers in the Server Manager window.

Promote To Primary Domain Controller on the Computer menu changes to Demote To Backup Domain Controller.

2 On the Computer menu, click Demote to Backup Domain Controller.

Notes
Usually, when a server is promoted to primary domain controller, no special action needs to be taken to demote the former 

primary domain controller to backup domain controller status, because the system does this automatically.
However, if a server is promoted to primary domain controller while the existing primary domain controller is unavailable 

(for example, if it is being repaired), and if the former primary domain controller later returns to service, you must demote it.

See Also

Promoting a Backup Domain Controller to Primary Domain Controller



Synchronizing a Backup Domain Controller with the Primary Domain Controller

To synchronize a backup domain controller with the primary domain controller

1 Select the server from the list in the Server Manager window.

2 On the Computer menu, click Synchronize with Primary Domain Controller.

Note
Synchronization is usually done automatically by the system, but if the domain directory database on a computer running 

Windows NT Server becomes unsynchronized or if a backup domain controller is unable to establish network connections due to 
password failure, use this manual method to correct the situation.

See Also

Synchronizing All Backup Domain Controllers of the Domain



Synchronizing All Backup Domain Controllers of the Domain

To synchronize all the backup domain controllers (BDCs) of the domain

1 Select the primary domain controller on the list in the Server Manager window.

2 On the Computer menu, click Synchronize Entire Domain.

The domain directory database is replicated from the primary domain controller to all the BDCs of the domain.

Note
Synchronizing is usually done automatically by the system, but if the domain directory database becomes unsynchronized 

between the primary domain controller and the BDCs, use this manual method to correct the situation. It is rarely necessary. It can 
take a substantial amount of time to complete.

See Also

Synchronizing a Backup Domain Controller with the Primary Domain Controller



Adding a Computer to the Domain

To add a computer to a domain

1 On the Computer menu, click Add to Domain.

2 In the Add Computer to Domain dialog box, select either Windows NT Workstation or Server or Windows NT Primary or 

Backup.

3 Type the computer name in Computer Name, and click Add. 

An account for that computer name is added to the domain directory database.

4 Click Close.

The computer is added to Server Manager's list.

5 After a computer has been added, instruct the user of that computer to join the domain. 

Notes
For workstations and servers this can be done either while installing Windows NT on the computer, or after installation 

using the Network tool in Control Panel of that computer. For domain controllers, this can only be done during installation.
To add a computer to a domain, you must be logged on to a user account that is a member of the Administrators, Domain 

Admins, or Account Operators group of that domain. 
After adding the computer to the domain, the computer's icon appears dimmed and its version number and description are 

absent in Server Manager's list until the computer joins the domain. 
Treat an added computer name as a security element. Until the intended computer joins the domain, it is possible for a 

user to give a different computer that computer name, and then have it join the domain using the computer account you have just 
created. If the added computer is a server, when it joins it receives a copy of the domain directory database.

See Also

Add To Domain



Removing a Computer from the Domain

To remove a computer from the domain

1 Select a computer from the list in the Server Manager window.

Do not select the primary domain controller; it cannot be removed.

2 On the Computer menu, click Remove from Domain.

3 Instruct the user of that computer to remove this domain name in the Network tool in Control Panel, and to enter (as 

appropriate) another domain name or workgroup name.



Changing a Computer Name

To change a computer name

1 On the Computer menu, click Add to Domain, and then enter the new computer name in the Add Computer to Domain 

dialog.

2 Instruct the user of that computer to change the computer name in the Network tool in Control Panel.

3 In the Server Manager window, select the old computer name from the list and click Remove from Domain on the Computer 

menu.

See Also

Adding a Computer to the Domain

Removing a Computer from the Domain



Services

Use the Services dialog box to start, stop, pause, or continue each of the services available on the selected computer, and to 

pass startup parameters to the service. 

For more information, click the following buttons.
 Service
 Status
 Startup
 Start
 Stop
 Pause
 Continue
 Startup
 Startup Parameters
 HW Profiles

See Also

Starting and Stopping Services

Configuring Service Startup

The Default Services



Service

You can select only one service at a time. Once selected, a service can be stopped, started, paused, continued, or configured for 

startup.



Status

The status of a service can be:
Started
Paused
Stopped (represented by a blank entry)



Startup

The startup type of a service can be:
Automatic (service starts every time the system starts)
Manual (service can be started by a user or a dependent service)
Disabled (service cannot be started)



Start 

To start a service that is stopped, select the service, and then click Start. 

Or, to pass startup parameters to the service, type in Startup Parameters before choosing Start.



Stop 

To stop a service that is running, select the service, and then click Stop. 

If another service is dependent on the service you stop, you will be warned before the action completes.

Note
Because stopping the Server service disconnects all remote connected users, warn users before stopping that service. 

Once the Server service is stopped, that computer can no longer be remotely administered, and its Server service can be restarted 
only locally.



Pause 

To pause a service that is running, select the service, and then click Pause.



Continue 

To return to normal operation a service that has been paused, select the service, and then click Continue.



Startup 

To specify the startup type of a service or to assign a logon account to a service, select the service, click Startup, and 
complete the dialog box that appears.

Note
To configure service startup, you must be logged on to a user account that has membership in the Administrators local 

group.



Startup Parameters

To pass startup parameters to a service, select the service, type the parameters in the Startup Parameters box, and then 
click Start. 

Backslashes are treated as an escape character. You must type two backslashes for each backslash in a parameter.



Hardware Profiles

To view the status of the hardware profile in use for the selected service and to enable or disable hardware profiles, click 
Profiles.



Service Startup

Use the Service Startup dialog box to configure when and how the service is started, and to specify the user account the 

service used to log on. 

For more information, click the following buttons.
 Startup Type
 Automatic
 Manual
 Disabled
 Log On As
 System Account
 Allow Service to Interact with Desktop
 This Account
 Browse
 Password and Confirm Password

See Also

Configuring Service Startup

The Default Services



Allow Service to Interact with Desktop

Select this check box if you want the service to provide a user interface on the desktop that can be used by anyone who is 

logged in when the service starts. This option can be used only if the service is running as a LocalSystem account (as defined in 

This Account). 



Startup Type

To specify the startup behavior of the service, click Automatic, Manual, or Disabled.



Automatic

Automatic services start every time the system starts.

Note
The Server service will not start automatically unless the computer has at least 12 MB of random-access memory.



Manual

Manual services can be started by a user or by a dependent service.



Disabled

Disabled services cannot be started by either users or dependent services.



Log On As

When services start, they log on. 

Most services must log on to the system account. Usually, of the default services provided with Windows NT only the Directory 

Replicator and Schedule services log on using other user accounts.



System Account

When services start, they log on. Most services must log on using the system account.



This Account

Select this option to assign a logon user account to a service.

When services start, they log on. Although most services must log on to the system account, some services can be configured to 

log on to special user accounts. (Usually, of the default services provided with Windows NT Workstation and Windows NT 

Server, only the Directory Replicator and Schedule services will be configured in this manner.)

A user account used to log on a service should be created in User Manager specifically for that purpose. Make certain that the 

user account has Password Never Expires selected and has membership in the appropriate groups. The particular group 

memberships assigned will depend on the operations that must be accomplished by the service.



Browse 

To specify the user account the service will log on to, select This Account, click Browse, and then make changes as 
needed in the Add User dialog box. 



Password and Confirm Password

In Password, type the password for the user account entered in This Account, and then type the same password in 
Confirm Password. 

This is the password that was assigned to the user account in User Manager. Remember, passwords are case sensitive.



Stopping Dependent Services

The listed services are dependent on the service that you are stopping. If you click OK, both the selected service and its 

dependent services will be stopped.



Properties

Use the Properties dialog box to view and manage the server properties of the selected computer.

For more information, click the following buttons.
 Usage Summary
 Sessions
 Open Files
 File Locks
 Open Named Pipes
 Description
 Users
 Shares
 In Use
 Replication
 Alerts

See Also

Managing Server Properties



Usage Summary

This box contains summaries of connections and resource usage for the selected computer.



Sessions

The number of users remotely connected to the computer.



Open Files

The number of files opened by connected users.



File Locks

The number of file locks by connected users.



Open Named Pipes

The number of open named pipes.

A named pipe is an interprocess communication mechanism that allows one process to communicate with another local or 

remote process.



Description

Can be any text. Typically, it might contain such information as the location of the computer, the name of the computer user, the 

user's telephone extension, the brand or model of the computer, or a description of the computer's function.

The description is an optional entry and can be left blank.



Users 

Click Users to see a list of all the users connected over the network to the computer, and for one selected user, a list of all 
open resources.

You can disconnect one or all of the users who are connected to the computer.



Shares 

Used to view a list of the computer's shared resources and, for one selected resource, a list of all the connected users. You can 

disconnect one or all of the users who are connected to the computer.

Note
To share directories or manage shared directories, select Shared Directories on the Server Manager Computer menu, 

or use Windows NT Explorer. To share printers or manage shared printers, use the Printers folder.



In Use 

Click In Use to view a list of the computer's open shared resources. 

Or, you can also close an open resource or all open resources.



Replication 

Click Replication to manage directory replication for the computer. 

For a server, also click Replication, to specify the path to user logon scripts.

Note
Directory replication exports copies of selected directories and files from this computer for storage on other computers, 

and imports selected directories and files from other computers for storage on this computer. Servers running Windows NT Server 
can export and import. Computers running Windows NT Workstation can only import.



Alerts 

Used to view and manage the list of users and computers that are notified when administrative alerts occur at the computer.

Administrative alerts are generated by the system and relate to server and resource use. They warn about security and access 

problems, user session problems, server shutdown because of power loss when the UPS service is available, and printer 

problems. 

For example, an alert is generated when disk space becomes low. You can determine which users and computers are notified 

when administrative alerts occur at the computer.



User Sessions

Use the User Sessions dialog box to view a list of all the users connected over the network to the computer, and a list of all the 

resources opened by a selected user. Or, you can disconnect one or all of the users connected to the computer. 

For more information, click the following buttons.
 Connected Users
 Computer
 Opens (for Connected User)
 Time (for Connected User)
 Idle
 Guest
 Number of Connected Users
 Resource
 Opens (for Resource)
 Time (for Resource)
 Disconnect
 Disconnect All

See Also

Viewing User Sessions
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Connected Users 

Lists the users who are connected to the computer over the network. 

Each entry consists of a user account icon, followed by a user name. In some cases, the user's computer name may be 

displayed instead of the user name.



Computer

The computer name of the connected user's computer.



Opens

The number of resources opened on this computer by this user.



Time

The hours and minutes that have elapsed since this session was established.



Idle

The hours and minutes that have elapsed since this user last initiated an action.



Guest

Whether this user is connected to this computer as a guest (shown as Yes or No).



Connected Users

The total number of users remotely connected to the computer.



Resource

Lists the shared resources to which the selected user is connected. Each entry consists of an icon indicating the type of 

resource, followed by the share name. A shared resource could be:

A shared directory

A named pipe

A shared printer

A communication-device queue (Microsoft LAN Manager 

servers only)

A resource of an unrecognized type

In some cases, a connection to a printer is monitored here as a connection to a named pipe.



Opens

For the selected user, the number of opens from the listed resource.



Time

The hours and minutes that have elapsed since this user first connected to the shared resource.



Disconnect 

To disconnect one user from the computer, select a user name in Connected Users, and then click Disconnect. 

Notes
Warn users before disconnecting them. If you do not, they may lose data.
While you are remotely administering another computer, your user account is listed as a user connected to the IPC$ 

resource. It will not be disconnected.



Disconnect All 

To disconnect all users from the computer, click Disconnect All. 

Notes
Warn users before disconnecting them. If you do not, they may lose data.
While you are remotely administering another computer, your user account is listed as a user connected to the IPC$ 

resource. It will not be disconnected.



Shared Resources

Use the Shared Resources dialog box to view a list of the shared resources available on the computer, and for a selected 

resource, a list of connected users. Optionally, you can disconnect one or all of the users connected to the computer. 

Note
To share directories or manage shared directories, use Shared Directories on the Server Manager Computer menu, or 

use Windows NT Explorer. To share printers or manage shared printers, use the Printers folder.

For more information, click the following buttons.
 Sharename
 Uses
 Path
 Connected Users
 Time
 In Use
 Number of Connected Users
 Disconnect
 Disconnect All

See Also

Viewing Shared Resources
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Sharename

Lists the shared resources available on the computer. Each entry consists of an icon representing the type of shared resource, 

followed by the share name. A shared resource could be:

A shared directory

A named pipe

A shared printer

A communication-device queue (Microsoft LAN Manager 

servers only)

A resource of an unrecognized type

In some cases, a connection to a printer is monitored here as a connection to a named pipe.



Uses

The number of connections to the shared resource.



Path

The path of the shared resource.



Connected Users 

This column lists the users who are connected to the selected shared resource. Each entry consists of a user account icon, 

followed by a user name. In some cases the user's computer name may be displayed instead of the user name.



Time

The hours and minutes that have elapsed since the user first connected to the selected shared resource.



In Use

Shows whether the user currently has a file open from the selected shared resource (shown as Yes or No).



Connected Users

The total number of users connected to the selected shared resource.



Disconnect 

To disconnect one user from all shared resources, select the user name from the list of Connected Users, and then click 
Disconnect. 

Notes
Warn users before disconnecting them. If you do not, they may lose data.
While you are remotely administering another computer, your user account is listed as a connected user for the IPC$ 

share. It will not be disconnected.



Disconnect All 

To disconnect all users from all shared resources, click Disconnect All. 

Notes
Warn users before disconnecting them. If you do not, they may lose data.
While you are remotely administering another computer, your user account is listed as a connected user for the IPC$ 

share. It will not be disconnected.



Open Resources

Used to view a list of the computer's open shared resources. 

Or, you can close one open resource or all open resources.

For more information, click the following buttons.
 Open Resources
 File Locks
 Opened By
 For
 Locks
 Path
 Refresh
 Close Resource
 Close All Resources

See Also

Viewing Resources In Use

Special Shares

Sharing a Directory

Managing Properties for a Shared Directory

Stopping Directory Sharing



Open Resources

The total number of resources that are open on the computer.



File Locks

The total number of file locks on open resources.



Opened By

Lists the open resources on the computer. Each entry consists of an icon representing the type of resource, followed by the user 

name (or sometimes the computer name) of the user who has opened the resource. An open resource could be:

A file

A named pipe

A print job in a print spooler

A communication-device queue (Microsoft LAN Manager 

servers only)

A resource of an unrecognized type

In some cases, a print job is shown here as an open named pipe.



For

The permission granted when the resource was opened.



Locks

The number of locks on the resource.



Path

The path of the open resource.



Refresh 

To update the display with current information. click Refresh.



Close Resource 

To close one resource, select a resource from the list of open resources, and then click Close Resource. 

Notes
Warn connected users before closing resources. If you do not, they may lose data.
While you are remotely administering another computer, your connection is displayed here as an open named pipe. It will 

not be closed.



Close All Resources 

To close all resources that are open on the computer, click Close All Resources. 

Notes
Warn connected users before closing resources. If you do not, they may lose data.
While you are remotely administering another computer, your connection is displayed here as an open named pipe. It will 

not be closed.



Password

You must provide a valid password to administer a LAN Manager 2.x server that is using share-level security.



Alerts

Used to view and manage the list of users and computers that are notified when administrative alerts occur at the selected 

computer. Administrative alerts are generated by the system, and relate to server and resource use. They warn about security 

and access problems, user session problems, server shutdown because of power loss when the UPS service is available, and 

printer problems.

For alerts to be sent, the Alerter and Messenger services must be running on the computer originating the alert. For alerts to be 

received, the Messenger service must be running on the destination computer.

For more information, click the following buttons.
 New Computer or User name
 Send Administrative Alerts To
 Add
 Remove

See Also

Managing Administrative Alerts



New Computer Or User Name

To add a user or computer to the list of alert recipients, type the user name or computer name in New Computer Or User, 
and then click Add.



Send Administrative Alerts To

Lists the computers and users who are notified when administrative alerts occur at this computer.



Add 

To add a user or computer to the list of alert recipients, type the user name or computer name in New Computer Or User, 
and then click Add.



Remove 

To remove a user or computer from the list of alert recipients, select the user name or computer name in Send 
Administrative Alerts To, and then click Remove.



Send Message

Used to send a message to all users who are connected to the selected computer. You may want to do this before you 

administer the computer with Server Manager, particularly if you will be disconnecting one or more users, or if you will be 

stopping the Server service on that computer.

For a message to be sent and received, the Messenger service must be running on the computer sending the message and on 

the computers receiving the message.

Message
In Message, type the text of your message.

See Also

Sending a Message to Connected Users



Add Computer to Domain

Before a computer running Windows NT can be a domain member and participate in domain security, it must be added to the 

domain. Computers that are added to a domain are given accounts in the domain directory database. There are three ways to 

add computers to a domain, but only one of them requires Server Manager. That method uses the Add Computer To Domain 

dialog box.
A computer can be added to a domain during installation of Windows NT Workstation or Windows NT Server, but only 

when the installation is performed by a domain Administrator.
An Administrator can add an existing computer running Windows NT to a domain using the Network tool in that 

workstation Control Panel.
An Administrator or Account Operator can use the Server Manager Add Computer to Domain dialog box to add a 

computer account to the domain directory database. Then the computer user must have the computer join the domain under that 
computer account. This can be accomplished by a user as part of the Windows NT installation; or, for any computer other than a 
primary or backup domain controller, after installation by using the Network tool in Control Panel.

Note
Treat the added computer name as a security element. Until the intended computer joins the domain, it is possible for a 

user to give a different computer that computer name, and then have it join the domain using the computer account you have just 
created. If the added computer is a server, when it joins it receives a copy of the domain directory database.

For more information, click the following buttons.
 Windows     NT Workstation or Server  
 Windows     NT Primary or Backup  
 Computer Name
 Add

See Also

Adding a Computer to the Domain



Windows NT Workstation or Server

If the computer runs Windows NT Workstation, or runs Windows NT Server but is not a primary or backup domain 
controller, click this option.



Windows NT Primary or Backup

If the computer is a domain controller with Windows NT Server installed, click this option.



Computer Name

A unique name of up to 15 characters by which the computer will be known to the network. The name cannot be the same as 

any other computer or domain name in the network.

You can type a name using both uppercase and lowercase characters, but the name is displayed in uppercase, and Windows NT 

stores the name in uppercase.



Add 

Adds the computer name to the domain directory database.



Select Domain

Displays your logon domain when Server Manager starts. Used to display a different domain, a Windows NT workgroup, or an 

individual computer.

For more information, click the following buttons.
 Domain
 Select Domain
 Low Speed Connection

See Also

Selecting a Domain

Using Low Speed Connection

Who Can Use Server Manager?



Domain

Select the option matching the type of information you want.
To display a domain, type the domainname in Domain, and click OK. 
To display a Windows NT workgroup, type the workgroupname in Domain and then click OK. 
To display only one computer, type the \\computername (precede computer names with two backslashes), and then click 

OK.



Select Domain

To display one of the listed domains, select that domain name in Select Domain, and click OK.



Low Speed Connection

When selecting a domain, workgroup, or computer that communicates with your computer across a connection providing 

relatively low transmission rates, select the Low Speed Connection check box. This prevents automatic refreshes of the Server 

Manager screen, which may be time consuming when performed across low speed connections. (These refreshes occur 

automatically after some Server Manager functions, such as changing computer properties, managing services, or promoting a 

server to primary domain controller.) When the Low Speed Connection check box is selected, the Server Manager screen can 

still be refreshed manually by clicking Refresh on the View menu.

For example, from a server running Windows NT Server you might administer a remote computer running both Windows NT 

Workstation and Microsoft Windows NT Remote Access Service, and which is connected to the network by a modem over 

telephone lines. When entering the computer name in the Server Manager Select Domain dialog box, select the Low Speed 

Connection check box.

Low Speed Connection can also be selected (or cleared) by clicking Low Speed Connection on the Options menu.



Add User

Used to select the user account the service will use to log on. 

This should be a user account created in User Manager specifically for logging on the service. Be sure to select Password 

Never Expires for the user account, and to set membership in the appropriate groups. The particular group memberships 

assigned depend on the operations that must be accomplished by the service. Usually, of the default services provided with 

Windows NT, only the Directory Replicator and Schedule services have a user account assigned in this manner.

For more information, click the following buttons.
 List Names From
 Names
 Add
 Search
 Add Name



List Names From

To change the selected domain or computer, select a domain name or computer name from the list in List Names From. 

List Names From shows the domain or computer from which the user account can be selected. The groups of that domain or 

computer are listed in Names.

An asterisk (*) next to a domain or computer name in List Names From indicates that the local groups of that domain or 

computer can be listed in Names. When the asterisk is absent, it indicates that local groups cannot be listed.



Names

Lists the user accounts of the domain or computer selected in List Names From.



Add 

After a name is selected in Names, click Add to place that name in Add Name.



Search 

To search for a particular user account, click Search, and select settings in the dialog box that appears.



Add Name

To instruct the service to log on using the account displayed in Add Name, click OK.

A user account can be added to this box by typing its name in the box; by selecting it in Names and clicking Add; or by clicking 

Search and completing the dialog box that appears.



Local Group Membership

Lists the user accounts and global groups that are members of the selected local group.

Members Of
To add user accounts or global groups to Add Names in the Add User dialog box, here select one or more names in 

Members Of, and click OK.

Members 
To list the members of a global group (that is itself a member of this local group), select the global group in Members Of, 

and click Members. 



Global Group Membership

Lists the user accounts that are members of the selected global group.

Members Of
To add user accounts to Add Names in the Add User dialog box, select one or more names in Members Of, and click 

OK.



Verify Synchronization

Synchronize with Primary Domain Controller reestablishes the account password on both that computer and on the primary 

domain controller. Usually, the system does this automatically, but if the computer becomes unsynchronized and is unable to 

establish network connections, this is a manual way to correct the situation. It is rarely necessary.



Verify Domain Synchronization

Synchronize Entire Domain replicates the latest changes to the domain directory database from the primary domain controller 

to all the servers in the domain. The system automatically performs directory synchronization, but if servers become 

unsynchronized, this is a manual way to correct the situation. 



Cannot Find Domain Controller

The domain controller for the specified domain could not be found. You may have entered an incorrect domain name, the domain 

controller may be currently unavailable to the network, or the specified domain may not exist.



Warning, No Primary Domain Controller

The primary domain controller for this domain cannot be found. During promotion of a backup domain controller to primary 

domain controller, the domain directory database of the old primary domain controller is usually replicated to the new primary 

domain controller. Then the old primary domain controller is demoted to backup domain controller status. This ensures that the 

new primary domain controller receives the domain's latest directory database.

If you proceed with the promotion while the primary domain controller is unavailable, the new primary domain controller's existing 

copy of the domain directory database will be used and may or may not be up-to-date. If you expect the primary domain 

controller to be available soon, it is a good idea to wait and to promote this server at that time.



Verify Role Change

During a promotion, the domain directory database from the old primary domain controller is replicated to the new primary 

domain controller. Then the old primary domain controller is demoted to backup domain controller status. This operation can take 

several minutes.

Changing the role of a server ends all client connections to that server, including Remote Access connections. 

If you are currently working at a computer that is connected to the network through a Remote Access connection, and either the 

server you want to promote or the current primary domain controller is the Remote Access server for your current connection, 

then you cannot successfully change the server's role. This is because your Remote Access connection will be ended before the 

operation is complete.

If this is the case, you should end your current Remote Access connection and reconnect, using another Remote Access server. 

Or, perform this action later, when you are not using a Remote Access connection.



Close Resources

Closing resources can result in loss of data. It is a good idea to send a warning to connected users before closing resources.

See Also

Sending a Message to Connected Users 



Close

Closing resources can result in loss of data. It is a good idea to send a warning to connected users before closing resources.

See Also

Sending a Message to Connected Users 



Disconnecting a User

Although disconnecting a user who is not using resources does not result in loss of data, it is a good idea to send a warning to 

connected users before disconnecting them. 

See Also

Sending a Message to Connected Users 



Disconnecting a User who is Using Resources

Disconnecting a user who is using resources can result in loss of data. It is a good idea to send a warning to connected users 

before disconnecting them.

See Also

Sending a Message to Connected Users 



Disconnecting Users

Although disconnecting users who are not using resources does not result in loss of data, it is a good idea to send a warning to 

connected users before disconnecting them.

See Also

Sending a Message to Connected Users 



Disconnecting Users who are Using Resources

Disconnecting users who are using resources can result in loss of data. It is a good idea to send a warning to connected users 

before disconnecting them.

See Also

Sending a Message to Connected Users 



Disconnecting All Users

Although disconnecting users who are not using resources does not result in loss of data, it is a good idea to send a warning to 

connected users before disconnecting them.

See Also

Sending a Message to Connected Users 



Disconnecting All Users who are Using Resources

Disconnecting users who are using resources can result in loss of data. It is a good idea to send a warning to connected users 

before disconnecting them.

See Also

Sending a Message to Connected Users



Disconnecting a Computer

Although disconnecting a computer that is not using resources does not result in loss of data, it is a good idea to send a warning 

to users on connected computers before disconnecting them. 

See Also

Sending a Message to Connected Users



Disconnecting All Computers

Disconnecting all computers can result in loss of data for those computers using resources. It is a good idea to send a warning to 

users on connected computers before disconnecting them.

See Also

Sending a Message to Connected Users



Directory Replication

Use the Directory Replication dialog box to manage replication properties for the computer, and to specify a local path to user 

logon scripts.

For more information, click the following buttons.
 Do Not Export
 Export Directories
 Manage (under Export Directories)
 From Path
 To List
 Do Not Import
 Import Directories
 Manage (under Import Directories)
 To Path
 From List
 Add
 Remove
 Logon Script Path

See Also

Managing Export Replication

Managing Import Replication

Setting the Logon Script Path

Assigning a Logon Account to the Directory Replicator Service



Do Not Export

Prevents replication from this computer. Subdirectories are not exported.



Export Directories

Enables replication from this computer. Subdirectories of From Path are exported.



Manage (under Export Directories)

Displays the Manage Exported Directories dialog box, where export locks can be added or removed, and export stabilization 

and subtree export can be enabled or disabled. 



From Path

A local path to a directory from which subdirectories and files are exported.

The default From Path is systemroot\SYSTEM32\REPL\EXPORT. Usually, you will not need to change the default From Path. 



To List

Subdirectories are exported from this export server to the domains and computers in To List.

By default, To List contains a blank entry, and this computer automatically exports to the local domain. If any entries are added 

to To List, the local domain is no longer exported to. If necessary, the domain name must be explicitly added to To List.

Replication to a domain name does not always succeed when some or all import computers of that domain are located across a 

wide area network (WAN) bridge from this export server. In this situation, you must explicitly add the computer names of those 

import computers to To List.



Do Not Import

Prevents replication to this computer. Subdirectories are not imported.



Import Directories

Allows replication to this computer. Subdirectories are imported.



Manage (under Import Directories)

Displays the Manage Imported Directories dialog box, where import locks can be added or removed.



To Path

A local path to a directory in which imported subdirectories and files are stored.

The default To Path is systemroot\SYSTEM32\REPL\IMPORT. Usually, you will not need to change the default To Path.



From List

Subdirectories are replicated to this import computer from the domains and computers of From List.

By default, From List contains a blank entry, and this computer automatically imports from the local domain. If any entries are 

added to From List, the local domain is no longer imported from. If necessary, the domain name must be explicitly added to 

From List.

Replication from a domain name does not always succeed when export servers of that domain are located across a wide area 

network (WAN) bridge from this import computer. In this situation, you must explicitly add the computer names of those export 

servers to the From List.



Add 

Displays the Select Domain dialog box.

Click Add in Export Directories to add a computer name or domain name to To List. 

Click Add in Import Directories to add a computer name or domain name to From List.



Remove 

Removes a selected computer name or domain name from the list.

Click Remove in Export Directories to remove a computer name or domain name to the To List. 

Click Remove in Import Directories to remove a computer name or domain name to the From List.



Logon Script Path

A local path to a directory where logon scripts are stored. When a server authenticates a logon request and that user account 

has a logon script assigned, the system locates the logon script by combining the local path that you specify here with a filename 

(and optionally a relative path) specified in User Manager.

For a domain, master copies of every logon script should be stored under one replication export directory of a primary or backup 

domain controller. Copies of these logon scripts should be replicated to the other servers of the domain. Then, the local path to 

imported logon scripts for every other domain controller should be entered in Logon Script Path. 

Usually, you will enter a path to a \SCRIPTS subdirectory of the replication To Path. For example, 

systemroot\SYSTEM32\REPL\IMPORT\SCRIPTS.

An entry is required. Do not enter a blank in Logon Script Path.



Directory Replication

Use the Directory Replication dialog box to manage replication properties for the computer.

For more information, click the following buttons.
 Do Not Import
 Import Directories
 Manage 
 To Path
 From List
 Add 
 Remove 

See Also

Managing Import Replication

Assigning a Logon Account to the Directory Replicator Service



Add 

Displays the Select Domain dialog box, used to add a computer or domain to From List.



Remove 

Removes a selected computer or domain from From List.



Manage Exported Directories

Used to add or remove export locks, and to enable or disable export stabilization and subtree export. 

For more information, click the following buttons.
 Export Path
 Subdirectory
 Locks
 Stabilize
 Subtree
 Locked Since
 Export Settings For
 Add Lock
 Remove Lock
 Wait Until Stabilized
 Entire Subtree
 Add
 Remove



Export Path

The path to the directory from which subdirectories and files are exported.



Subdirectory

A list of the subdirectories that are exported from this computer.

When a subdirectory is created in the export path (using Windows NT Explorer or the command prompt), it is automatically 

added to this list.



Locks

The number of locks applied to the subdirectory.

A lock prevents subdirectory export, and more than one lock might be applied to a subdirectory. Export occurs only if this column 

has a value of zero.



Stabilize

Yes indicates that all files and subdirectories in that subdirectory tree must be stable (cannot be changed) for two minutes (or 

more) before replication can occur. No indicates that each file can be replicated as soon as it is changed.

The default is No. To change this setting, select the Wait Until Stabilize check box.



Subtree

Yes indicates that the entire subdirectory tree will be exported. No indicates that only the first-level subdirectory will be exported. 

The default is Yes. To change this setting, select the Entire Subtree check box.



Locked Since

The date and time that the oldest lock was placed on this subdirectory.



Export Settings For

Shows the name of the selected subdirectory.



Add Lock 

Adds a lock to the selected subdirectory, preventing export.



Remove Lock 

Removes a lock from the selected subdirectory. Export occurs only when a subdirectory has zero locks. 



Wait Until Stabilized

Helps to eliminate partial replication. If selected, no changes can occur to any subdirectory or file in the selected subdirectory 

tree for two minutes (or more) before replication can occur. If cleared, each file can be replicated as soon as it is changed. 

This setting is reflected under Stabilize.



Entire Subtree

If selected, the first-level export subdirectory, its subdirectories, and all the files these contain will be exported. If cleared, only the 

first-level export subdirectory and its files will be exported. 

This setting is reflected under Subtree.



Add 

Displays the Add Subdirectory dialog box, used to add new subdirectories to the list of exported subdirectories.

This is usually unnecessary because it adds an entry only to the list, and does not actually create the subdirectory. When a 

subdirectory is created in the export path (using Windows NT Explorer or the command prompt), it is automatically added to the 

list.



Remove 

Removes the selected subdirectory from the list of exported subdirectories.

This is usually unnecessary because it removes only the entry on the list, not in the actual subdirectory. If that subdirectory still 

exists in the export path, it will still be exported and will later reappear in this list.



Manage Imported Directories

Used to add or remove import locks.

For more information, click the following buttons.
 Import Path
 Subdirectory
 Locks
 Status
 Last Update
 Locked Since
 Import Settings For
 Add Lock
 Remove Lock
 Add
 Remove



Import Path

The path to the directory in which replicated subdirectories and files are stored.



Subdirectory

Lists the replicated subdirectories that are imported to this computer. 

A subdirectory is automatically imported if it is exported by one of the export servers or domains in From List in the Directory 

Replication dialog box. If the subdirectory is imported, it is automatically added to this list.



Locks

A lock prevents import to the subdirectory. More than one lock might be applied to a subdirectory. Import to a subdirectory only 

occurs if this column has a value of zero.



Status

OK indicates that the subdirectory is receiving regular updates from an export server and the imported data is identical to 
that exported.

No Master indicates that the subdirectory is not receiving updates. The export server might not be running, or the export 
server might have stopped exporting updates.

No Sync indicates that the subdirectory has received updates, but the data is not up-to-date. This could be due to a 
communications failure, to open files on the import computer or export server, to the import computer not having access permissions 
at the export server, or to an export server malfunction.

A blank entry indicates that replication has never occurred for that subdirectory. Replication may not be properly 
configured for this import computer, for the export server, or both.



Last Update

The date and time that the last update was made to a file in this import subdirectory or in its subtree.



Locked Since

The date and time that the oldest lock was placed on this subdirectory.



Import Settings For

Shows the name of the selected subdirectory.



Add Lock 

Adds a lock to the selected subdirectory, preventing import.



Remove Lock 

Removes a lock from the selected subdirectory. Import occurs only when a subdirectory has zero locks. 



Add 

Displays the Add Subdirectory dialog box, used to add new subdirectories to the list of imported subdirectories.

This is usually unnecessary because this adds an entry only to the list, and does not create the actual subdirectory. When a 

subdirectory is exported by one of the export servers or domains in From List in the Directory Replication dialog box, it is 

automatically imported and added to this list.



Remove 

Removes the selected subdirectory from the list.

This is usually unnecessary, because this removes the entry only from the list, and does not remove the actual subdirectory. If 

that subdirectory is exported by one of the export servers or domains in the From List of the Directory Replication dialog box, 

it will still be imported and will later reappear in this list.



Add Subdirectory

Used to add a subdirectory to Subdirectory. 

However, this is usually unnecessary, since this action adds an entry only to the list, and does not create the actual subdirectory. 

Instead, use Windows NT Explorer or the command prompt to create export subdirectories on export servers. On import 

computers, imported subdirectories are automatically created the first time they are received from an exporting server.

Path

This is either the import path or the export path.

Subdirectory Name
To add a subdirectory to the list, type its name in Subdirectory Name, and then click OK.



Select Domain

Used to select a domain or a computer to be added to the replication From List or the replication To List.

Replicating to or from a domain name is a convenient way to set up directory replication between many computers, because 

each export server and import computer can specify only a few domain names for export or import rather than a long list of many 

computer names.

Domain

Displays the current domain. You can type a domainname or a \\computername here.

Select Domain

Lists the available domains. To see a list of the computers in a domain, double-click the domain name. You can then select one 

of the listed domains or computers.



Shared Directories

Used to share, stop sharing, modify properties of, and manage permissions for shared directories. A shared directory can be 

accessed by network users.

For more information, click the following buttons.
 Shared Directories On
 New Share
 Properties
 Stop Sharing

See Also

Sharing a Directory

Managing Properties for a Shared Directory

Stopping Directory Sharing

Special Shares

Viewing Shared Resources

Viewing Resources In Use



Shared Directories On

Lists the shared directories of the computer, and shows the path of each.

The list consists of those resources that have been shared by a user or an administrator, plus any special shares that may have 

been created by the system (for example, A$, B$, C$, ADMIN$, IPC$, NETLOGON, PRINT$ or REPL$).



New Share 

To share a directory, click New Share and select settings in the New Share dialog box that appears.



Properties 

To view or manage the properties of a shared directory, select the shared directory in Share Directories On, click 
Properties, and then select settings in the Share Properties dialog box.



Stop Sharing 

To stop sharing a directory, select the shared directory in Share Directories On, and then click Stop Sharing.

The directory itself is not removed, but it is no longer shared and can no longer be accessed by network users.



New Share

Used to share a directory. A shared directory can be accessed by network users.

For more information, click the following buttons.
 Share Name
 Path
 Comment
 User Limit
 Maximum Allowed
 Allow
 Users
 Permissions

See Also

Sharing a Directory

Setting Permissions for a Shared Directory



Share Name

The name used to identify and connect to this share. Share names can have up to 12 characters. 

If computers running MS-DOS will be connecting to this share, share names should be limited to 8 characters, optionally 

followed by a period and up to 3 more characters.



Path

The path of a local directory to be shared. 

For example, you might type c:\sales\budgets.



Comment

Any text describing the shared directory. Users see this comment when connecting to the shared directory using Windows NT 

Explorer.

This is an optional entry.



User Limit

Defines the maximum number of users who can connect to the shared directory at one time.



Maximum Allowed

There is no limit on connections to this shared directory. There may be a limit, however, on how many users can connect to this 

computer overall.



Allow

Only the number of users specified in Users can connect at one time to the shared directory.



Users

The maximum number of network users who can connect at one time to the shared directory.



Permissions 

Permissions determine which users are allowed to access the shared directory and the type of access those users are allowed. 

The default is to grant Full Control to Everyone.
To manage permissions for the shared directory, click Permissions and select settings in the Access Through Share 

Permissions dialog box.



Share Properties

Use the Share Properties dialog box to view and manage the path, comment, user limit, or permissions for the selected shared 

directory.

For more information, click the following buttons.
 Share Name
 Path
 Comment
 User Limit
 Maximum Allowed
 Allow
 Users
 Permissions

See Also

Managing Properties for a Shared Directory

Setting Permissions for a Shared Directory

Special Shares

Viewing Shared Resources

Viewing Resources In Use



Share Name

The name of the selected shared directory.



Access Through Share Permissions

Share permissions determine which users are allowed to access a shared directory, and the type of access those users are 

allowed. These permissions control network access to the shared directory, its subdirectories, and their files. Share permissions 

are effective only when the shared directory is accessed over the network.

Permissions set on a share that is on an NTFS volume operate in addition to NTFS permissions set on the directory itself. On 

NTFS volumes, share permissions specify the maximum access possible, while directory and file permissions specify the 

maximum access allowed. For NTFS volumes it is usually better to restrict access by managing the permissions set on 

directories and files, rather than the permissions set on shares.

Use the Access through Share Permissions dialog box to add, remove, or change share permissions assigned to groups or 

user accounts.

For more information, click the following buttons.
 Share Name
 Owner
 Name
 Type of Access
 Add
 Remove

See Also

Types of Access Permissions

Setting Permissions for a Shared Directory



Share Name

The shared directory for which permissions are being managed.



Owner

The owner of the shared directory.



Name

Lists the groups and user accounts granted permissions for this shared directory, and shows the type of access granted to each.



Type of Access

Lists the permissions that can be granted to the groups and user accounts listed in Name.
To change the type of access granted to a group or user account, select the group or user account from Name, and then 

select a permission in Type of Access.



Add 

To add a group or user account to the list of those granted permissions for the shared directory, click Add, and select 
settings in the Add Users and Groups dialog box.



Remove 

To remove a group or user account from the list of those granted permissions for the shared directory, select the group or 
user account from Name, and then click Remove.



Invalid Local Path

You must provide an absolute path for the directory to be shared. It must be a path local to computer that is being administered. 

For example, you might create a share named INVOICES with a path of C:\SHIPPING\INVOICE.



Invalid Share Name

The share name is a name used to identify and connect to this share. Share names can be up to 12 characters. If computers 

running MS-DOS will be connecting to this share, share names should be limited to 8 characters, optionally followed by a period 

and up to 3 more characters.



Cannot Change Share Path

By default, some special shares are provided by the system, and the paths for these special shares cannot be changed.

You can change the comment, user limit, and permissions.



Share Name not Accessible from MS-DOS

Share names can be up to 12 characters. If computers running MS-DOS will be connecting to this share, share names should be 

limited to 8 characters, optionally followed by a period and up to 3 more characters.



Current Users Warning

Appears when you have issued Stop Sharing against a share to which users are connected and have open files. You should 

warn connected users before disconnecting them. If you click OK and continue, the connected users may lose data. 



Add Users and Groups

Used to add groups or user accounts to the list of those granted permissions for the shared directory.

For more information, click the following buttons.
 List Names From
 Names
 Add
 Show Users
 Members
 Search
 Add Names
 Type of Access

See Also

Types of Access Permissions

Setting Permissions for a Shared Directory



List Names From

Shows the domain or computer from which groups and user accounts can be selected.

When an asterisk (*) appears next to a domain or computer name in List Names From, it indicates that the local groups of that 

domain or computer can be listed in Names. When the asterisk is absent, it indicates that local groups cannot be listed.
To change the selected domain or computer, select a domain name or computer name from the list in List Names From. 



Names

Lists the groups of the domain or computer selected in List Names From. If Show Users is selected, it also lists the user 

accounts.



Add 

After a name has been selected from Names, clicking Add places that name in Add Names.



Show Users 

Shows the user accounts in Name. 

Note
By default, only groups of the selected domain or computer are listed in Name.



Members 

To list the members of a group, select the group from Names, and then click Members. 



Search 

To search for a particular group or user account, click Search, and select settings in the dialog box that appears.



Add Names

You can add groups and user accounts by:
Typing names (separated by semicolons) in Add Names.
Selecting them in Names and clicking Add.
Clicking Search and completing the dialog box that appears.
Selecting a group from Names, clicking Members, and completing the dialog box that appears.

Note
To add the names in Add Names to the list of names granted permissions for the shared directory, click OK.



Type of Access

To specify the permission to be granted to all the groups and user accounts listed in Add Names, select a permission in 
Type of Access.



Local Group Membership

Lists the user accounts and global groups that are members of the selected local group.

To add user accounts or global groups to Add Names in the Add Users and Groups dialog box 
In the Local Group Membership dialog box, select one or more names in Members Of, and then click OK.

To list the members of a global group (that is itself a member of this local group) 
Select the global group in Members Of, and then click Members. 



Global Group Membership

Lists the user accounts that are members of the selected global group.

To add user accounts to Add Names in the Add Users and Groups dialog box 
In the Global Group Membership dialog box, select one or more names in Members Of, and then click OK.



Find Account

Used to locate a particular user account or group.

For more information, click the following buttons.
 Find User or Group
 Search All
 Search Only In
 Search
 Search Results
 Add



Find User or Group

Type the name you want to search for In Find User or Group. 

The system will search only for user accounts or groups of that exact name.



Search All

When selected, sets the search for a matching user or group name in the local domain or computer and in all domains trusted by 

the local domain.



Search Only In

When selected, sets the search for a matching user or group name to look only in the domains and computers you have selected 

from the list. 

The list includes the local domain or computer, and all domains trusted by the local domain.



Search 

Begins a search based on the parameters specified in Find User or Group, and in Search All or Search Only In.



Remote Administration not Supported for Shared Directories

The shared directories of the selected computer cannot be remotely administered. This could happen because the required, 

special IPC$ share does not exist at that computer.



Invalid Share Permissions

You must enter any combination of the letters RWCXDAP, with no duplicates.

R (read) 

W (write) 

C (create) 

D (delete) 

X (execute) 

A (change attributes) 

P (change permissions)



Invalid Share Comment

The entered comment is not valid. Enter a new comment.



Invalid Share Path

You must provide an absolute path for the directory that is to be shared. It must be a path local to computer that is being 

administered. 

For example, you might create a share named INVOICES with a path of C:\SHIPPING\INVOICE.



Invalid User Limit

The entered user limit is not valid. Enter a new user limit.



Invalid Path for Special Share

ADMIN$ or IPC$ are special shares. Usually, they are created automatically by the system. If you create one of these shares 

using the New Share dialog box, complete only Share Name. Leave Path and Comment empty.



Invalid Comment for Special Share

ADMIN$ or IPC$ are special shares. Usually, they are created automatically by the system. If you create one of these shares 

using the New Share dialog box, complete only Share Name. Leave Comment and Path empty.



New Share Password

You are administering a shared directory of a LAN Manager 2.x server that is running share-level security, and you have 

specified a new password for the share. A user will need to provide the new password in order to connect to this share.

If this is what you intended, click OK ; if not, click Cancel.



Shared Directory Path Change Warning

You have entered a new path for an existing shared directory. In effect, you are stopping sharing of the existing shared directory, 

and are sharing another directory under the existing share name.

If this is what you intended, click OK ; if not, click Cancel.



Cannot Set Permissions

Server Manager cannot set permissions on a LAN Manager server running user-level security.



Password for Shared Directories Administration

You are attempting to administer the shared directories of a LAN Manager 2.x server that is running share-level security. You 

must provide a password valid for the special ADMIN$ share on that server.



Share Permissions

Used to set the access type and password for the selected share.

For more information, click the following buttons.
 Access Type
 Read Only
 Change
 Other
 Password



Access Type

Specifies one set of permissions for the selected shared directory. These permissions apply to everyone who uses the directory.



Read Only

Users can read and copy files, run programs, change from one subdirectory to another within the shared directory, and read the 

extended attributes of files.



Change

Users have RWCXDA permissions.

R (read) 

W (write) 

C (create) 

D (delete) 

X (execute) 

A (change attributes) 



Other

To specify permissions other than read or change, enter any combination of the letters RWCXDAP, with no duplicates.

R (read) 

W (write) 

C (create) 

D (delete) 

X (execute) 

A (change attributes) 

P (change permissions)



Password

Enter a password for this shared directory. Users must provide this password in order to access the directory. A password can 

have as many as 14 characters.



Cannot Find Server

The specified server cannot be located.



Find Account

Used to locate a particular user account or group.

For more information, click the following buttons.
 Find User or Group
 Search All
 Search Only In
 Search
 Search Results
 Add



Search Results

Contains a list of user accounts and groups found during a search. This list is continuously filled as a search progresses. 

One or more names can be selected in Search Results and then added to Add Name in the Add User dialog box by clicking 

Add here in the Find Account dialog box.

The list presents the matching users in the form domainname\user name (full name) description or computername\user name 

(full name) description.

The list presents the matching groups in the form domainname\groupname description or computername\groupname 

description.



Search Results

Contains a list of user accounts and groups found during a search. This list is continuously filled as a search progresses. 

One or more names can be selected from Search Results and then added to Add Names in the Add Users and Groups dialog 

box by clicking Add here in the Find Account dialog box.

The list presents the matching users in the form domainname\user name (full name) description or computername\user name 

(full name) description.

The list presents the matching groups in the form domainname\groupname description or computername\groupname 

description.



Add 

Closes the Find Account dialog box, and adds the accounts selected in Search Results to Add Name in the Add User dialog 

box.



Add 

Closes the Find Account dialog box, and adds the accounts selected in Search Results to Add Names in the Add Users and 

Groups dialog box.



Types of Access Permissions

For information on the types of access permissions that can be applied to shared directories, click the following buttons.
 No Access
 Read
 Change
 Full Control

Note
When a directory is shared, the default is to grant the special Everyone group Full Access permissions.

See Also

Setting Permissions for a Shared Directory



No Access

Prevents any access to the shared directory, its subdirectories, and their files.



Read

Allows:
Viewing filenames and subdirectory names. 
Traversing to subdirectories. 
Viewing data in files.
Running application files. 



Change

Allows:
Viewing filenames and subdirectory names. 
Traversing to subdirectories. 
Viewing data in files. 
Running application files. 
Adding files and subdirectories. 
Changing data in files. 
Deleting subdirectories and files. 



Full Control

This is the default permission applied to any new shares you create. It allows:
Viewing filenames and subdirectory names. 
Traversing to subdirectories. 
Viewing data in files. 
Running application files. 
Adding files and subdirectories. 
Changing data in files. 
Deleting subdirectories and files. 
Changing permissions (NTFS files and directories only). 
Taking ownership (NTFS files and directories only). 



Demoting a Remote Access Server

Changing the role of a server ends all client connections to that server, including Remote Access connections. 

If you are currently working at a computer that is connected to the network through a Remote Access connection, and the 

primary domain controller that you want to demote is the Remote Access server for your current connection, then you cannot 

successfully change the server role. This cannot happen because your Remote Access connection will be ended before the 

operation is complete.

If this is the case, you should end your current Remote Access connection and reconnect, using another Remote Access server. 

Or, perform this action later, when you are not using a Remote Access connection.



Changing the Role of a Remote Access Server

Changing the role of a server ends all client connections to that server, including Remote Access connections. 

If you are currently working at a computer that is connected to the network through a Remote Access connection, and either the 

server you want to promote or the current primary domain controller is the Remote Access server for your current connection, 

then you cannot successfully change the server role. This cannot happen because your Remote Access connection will be 

ended before the operation is complete.

If this is the case, you should end your current Remote Access connection and reconnect, using another Remote Access server. 

Or, perform this action later, when you are not using a Remote Access connection.



Service Hardware Profiles

Use the Service hardware profiles dialog box to enable and disable services when you boot the system using specific 

hardware profiles.

For more information, click the following buttons.
 Status
 Profile
 Enable
 Status



Status

If Enabled is displayed under Status, the service is enabled when you boot the system using the associated hardware profile. A 

service can be either enabled or disabled for a hardware profile.



Profile

Displays hardware configurations you can choose at startup. You use the System tool in Control Panel to create hardware 

profiles and set their order of preference.



Enable

To enable this service for a hardware profile, select the hardware profile and click Enable.



Disable

To disable this service for a hardware profile, select the hardware profile and click Disable.



Click Help Topics for a list of Help topics. 




